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Ghini è un programma per la gestione di collezioni di oggetti botanici. Con Ghini puoi creare una base dati di registri di piante, con molte opzioni di ricerca.

Ghini è software aperto [http://www.opensource.org] e libero [http://www.fsf.org] ed è distribuito secondo la GPL: Licenza Pubblica GNU [http://www.fsf.org/licensing/licenses/gpl.html]
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Ghini’s goals and highlights

Should you use this software? This question is for you to answer. We trust
that if you manage a botanic collection, you will find Ghini overly useful
and we hope that this page will convince you about it.

This page shows how Ghini makes software meet the needs of a botanic garden.


Botanic Garden

According to the Wikipedia, »A botanic(al) garden is a garden dedicated to
the collection, cultivation and display of a wide range of plants labelled
with their botanical names«, and still according to the Wikipedia, »a
garden is a planned space, usually outdoors, set aside for the display,
cultivation, and enjoyment of plants and other forms of nature.«

So we have in a botanic garden both the physical space, the garden, as its
dynamic, the activities to which the garden is dedicated, activities which
makes us call the garden a botanic garden.


[image: _images/garden_worries_1.png]
the physical garden




[image: _images/garden_worries_2.png]
collection related activities in the garden






Botanic Garden Software

At the other end of our reasoning we have the application program Ghini, and
again quoting the Wikipedia, »an application program is a computer program
designed to perform a group of coordinated functions, tasks, or activities
for the benefit of the user«, or, in short, »designed to help people perform
an activity«.

Data and algorithms within Ghini have been designed to represent the
physical space and the dynamic of a botanic garden.


[image: _images/ghini-10.svg]core structure of Ghini’s database



The central element in Ghini’s point of view is the Accession. Following
its links to other database objects lets us better understand the structure:


An Accession represents the action of receiving plant material in
the garden. As such, Accession is an abstract concept, it links
physical living Plantings —groups of plants placed each at a
Location in the garden— to the corresponding Species. An
Accession has zero or more Plantings associated to it (0..n), and
it is at all times connected to exactly 1 Species. Each Planting
belongs to exactly one Accession, each Species may have multiple
Accessions relating to it.

An Accession stays in the database even if all of its Plantings
have been removed, sold, or have died. Identifying the Species of an
Accession consistently connects all its Plantings to the
Species.

Propagations and Contacts provide plant material for the garden;
this information is optional and smaller collectors might prefer to leave this aside.
A Propagation trial may be unsuccessful, most of the time it will result
in exactly one accession, but it may also produce slightly different taxa,
so the database allows for zero  or more Accessions per Propagation (0..n).
Also a Contact may provide zero or more Accessions (0..n).

Specialists may formulate their opinion about the Species to which an
Accession belongs, by providing a Verification, signing it, and
stating the applicable level of confidence.

If an Accession was obtained in the garden nursery from a successful
Propagation, the Propagation links the Accession and all of
its Plantings to a single parent Planting, the seed or the
vegetative parent.




Even after the above explanation, new users generally still ask why they
need pass through an Accession screen while all they want is to insert a
Plant in the collection, and again: what is this “accession” thing
anyway?  Most discussions on the net don’t make the concept any clearer.
One of our users gave an example which I’m glad to include in Ghini’s
documentation.





	use case:	
	At the beginning of 2007 we got five seedlings of Heliconia
longa (a plant Species) from our neighbour (the
Contact source). Since it was the first acquisition of the
year, we named them 2007.0001 (we gave them a single unique
Accession code, with quantity 5) and we planted them all
together at one Location as a single Planting, also
with quantity 5.

	At the time of writing, nine years later, Accession
2007.0001 has 6 distinct Plantings, each at a different
Locations in our garden, obtained vegetatively (asexually)
from the original 5 plants. Our only intervention was
splitting, moving, and of course writing this information in
the database. Total plant quantity is above 40.

	New Plantings obtained by (assisted) sexual Propagation
come in our database under different Accession codes, where
our garden is the Contact source and where we know which of
our Plantings is the seed parent.









the above three cases translate into several short usage stories:


	activate the menu Insert → Accession, verify the existence and
correctness of the Species Heliconia longa, specify the initial
quantity of the Accession; add its Planting at the desired
Location.

	edit Planting to correct the amount of living plants — repeat this as
often as necessary.

	edit Planting to split it at separate Locations — this produces a
different Planting under the same Accession.

	edit Planting to add a (seed) Propagation.

	edit Planting to update the status of the Propagation.

	activate the menu Insert → Accession to associate an accession to a
successful Propagation trial; add the Planting at the desired
Location.



In particular the ability to split a Planting at several different
Locations and to keep all uniformly associated to one Species, or
the possibility to keep information about Plantings that have been
removed from the collection, help justify the presence of the Accession
abstraction level.



Our User Stories section contains details about the above, and more.






Highlights

not-so-brief list of highlights, meant to whet your appetite.


taxonomic information

When you first start Ghini, and connect to a database, Ghini will
initialize the database not only with all tables it needs to run, but it
will also populate the taxon tables for ranks family and genus, using the
data from the “RBG Kew’s Family and Genera list from Vascular Plant Families
and Genera compiled by R. K. Brummitt and published by the Royal Botanic
Gardens, Kew in 1992”.  In 2015 we have reviewed the data regarding the
Orchidaceae, using “Tropicos, botanical information system at the Missouri
Botanical Garden - www.tropicos.org” as a source.




importing data

Ghini will let you import any data you put in an intermediate json
format. What you import will complete what you already have in the
database. If you need help, you can ask some Ghini professional to help you
transform your data into Ghini’s intermediate json format.




synonyms

Ghini will allow you define synonyms for species, genera, families. Also
this information can be represented in its intermediate json format and be
imported in an existing Ghini database.




scientific responsible

Ghini implements the concept of ‘accession’, intermediate between physical
plant (or a group thereof) and abstract taxon. Each accession can associate
the same plants to different taxa, if two taxonomists do not agree on the
identification: each taxonomist can have their say and do not need overwrite
each other’s work. All verifications can be found back in the database, with
timestamp and signature.




helps off-line identification

Ghini allows you associate pictures to physical plants, this can help
recognize the plant in case a sticker is lost, or help taxonomic
identification if a taxonomist is not available at all times.




exports and reports

Ghini will let you export a report in whatever textual format you need. It
uses a powerful templating engine named ‘mako’, which will allow you export
the data in a selection to whatever format you need. Once installed, a
couple of examples are available in the mako subdirectory.




annotate your info

You can associate notes to plants, accessions, species, .... Notes can be
categorized and used in searches or reports.




garden or herbarium

Management of plant locations.




database history

All changes in the database is stored in the database, as history log. All
changes are ‘signed’ and time-stamped.  Ghini makes it easy to retrieve the
list of all changes in the last working day or week, or in any specific
period in the past.




simple and powerful search

Ghini allows you search the database using simple keywords, e.g.: the name
of the location or a genus name, or you can write more complex queries,
which do not reach the complexity of SQL but allow you a decent level of
detail localizing your data.




database agnostic

Ghini is not a database management system, so it does not reinvent the
wheel. It works storing its data in a SQL database, and it will connect to
any database management system which accepts a SQLAlchemy connector. This
means any reasonably modern database system and includes MySQL, PostgreSQL,
Oracle. It can also work with sqlite, which, for single user purposes is
quite sufficient and efficient. If you connect Ghini to a real database
system, you can consider making the database part of a LAMP system
(Linux-Apache-MySQL-Php) and include your live data on your institution web
site.




language agnostic

The program was born in English and all its technical and user documentation
is still only in that language, but the program itself has been translated
and can be used in various other languages, including Spanish (86%),
Portuguese (100%), French (42%), to name some Southern American languages,
as well as Swedish (100%) and Czech (100%).




platform agnostic

Installing Ghini on Windows is an easy and linear process, it will not take
longer than 10 minutes. Ghini was born on Linux and installing it on ubuntu,
fedora or debian is consequently even easier. MacOSX being based on unix, it
is possible to successfully run the Linux installation procedure on any
recent Apple computer, after a few preparation steps.




easily updated

The installation process will produce an updatable installation, where
updating it will take less than one minute. Depending on the amount of
feedback we receive, we will produce updates every few days or once in a
while.




unit tested

Ghini is continuously and extensively unit tested, something that makes
regression of functionality close to impossible. Every update is
automatically quality checked, on the Travis Continuous Integration
service. Integration of TravisCI with the github platform will make it
difficult for us to release anything which has a single failing unit test.

Most changes and additions we make, come with some extra unit test, which
defines the behaviour and will make any undesired change easily visible.




customizable/extensible

Ghini is extensible through plugins and can be customized to suit the needs
of the institution.









          

      

      

    

  

    
      
          
            
  
Mission & Vision

Here we state who we are, what we think of our work, what you can expect of
this project.


Who is behind Ghini

Ghini started as a one-man project, by Brett Adams. He started this software
as Bauble, for and at the Belize Botanical Garden, and later on adapted it
to the needs of a couple of other users who asked him. Brett made Bauble a
commons, by releasing it under a GPL license.

After some years of stagnation Mario Frasca took responsibility of updating
Bauble, rebranded it to Ghini, in honour of Luca Ghini, started adocating,
travelling, distributing, developing, documenting it, and it is now Mario
Frasca writing this, enhancing the software, looking for users, requesting
feedback...

So currently behind Ghini there’s not only one developer, but much more
importantly, a small but growing global users community.

Translations are provided by volunteers who mostly stay behind the scenes,
translating a couple of missing terms or sentences, and disappearing again.

To make things clearer when we speak of Ghini, but should—and in this
document we will—indicate whether it’s Ghini(the software), or Ghini(the
people), unless obviously we mean both things.




Mission

The Mission Statement is a purpose, it defines the rationale of an entity
and is specific and true. For Ghini, the Mission Statement sets out the
social order to which Ghini is committed, the needs that are satisfied with
Ghini(the software) and with the services of Ghini(the people), the market
in which Ghini develops and its intended public image.


	access to software

	access to development

	bundling resources

	open source

	open data

	community forming






Vision

The Vision serves to indicate the way ahead and projects a future image of
what we want our organization to be, in a realistic and attractive way.  It
serves as motivation because it visualizes the challenge and direction of
necessary changes in order to grow and prosper.


	by the year 2020

	reference point

	community

	development

	integration with web portal

	geographic information









          

      

      

    

  

    
      
          
            
  
Istallazione

ghini.desktop è un programma multipiattaforma e funziona su macchine unix (Linux e MacOSX) ma anche su Windows.

Per installare Ghini, c’è bisogno di soddifare un paio di dipendenze che non possono essere risolte automaticamente. Queste includono virtualenvwrapper, PyGTK e pip. Python è presente su ogni macchina unix, mentre GTK+ è nativo di Linux ed altrimenti va installato. Dopo aver soddisfatte queste richieste, è possibile lasciare a Ghini il compito di risolvere tutte le altre.


Nota

Seguendo le seguenti istruzioni di installazione si ottiene un Ghini installato in un ambiente Python virtuale, tutte le dipendenze saranno installate localmente e non entreranno in conflitto con altri programmi Python che possono essere sullo stesso elaborator.

se dovessi in seguito decidere di rimuovere Ghini, basterà rimuovere l’ambiente virtuale, che è una directory, con tutto il suo contenuto.




Installare su Linux

Open a shell terminal window, and follow these instructions.


technical note

You can study the script to see what steps if runs for you. In
short it will install dependencies which can’t be satisfied in a
virtual environment, then it will create a virtual environment
named ghide, use git to download the sources to a directory
named ~/Local/github/Ghini/ghini.desktop, and connect this
git checkout to the ghini-1.0 branch (this you can consider a
production line), it then builds ghini, downloading all remaining
dependencies in the virtual environment, and finally it creates a
startup script. If you have sudo permissions, it will be
placed in /usr/local/bin, otherwise in your ~/bin
folder. Again if you




beginner’s note

To run a script, first make sure you note down the name of the
directory to which you have downloaded the script, then you open
a terminal window and in that window you type bash followed by
a space and the complete name of the script including directory
name, and hit on the enter key.




	Scaricare il programmino devinstall.sh ed eseguirlo:

https://raw.githubusercontent.com/Ghini/ghini.desktop/master/scripts/devinstall.sh





Please note that the script will not help you install any extra database
connector. This is not strictly necessary and you can do it at any later step.

Se il programmino di installazione termina senza errori, si può ora avviare ghini:

~/bin/ghini





o aggiornare ghini all’ultima versione rilasciata nella linea di produzione:

~/bin/ghini -u





The same script you can use to switch to a different production line.
At the moment it’s just ghini-1.0 and ghini-1.1.



	su Unity, apri un terminale, avvia ghini, la sua icona (il signor Ghini mostrando il suo erbario) apparirà nel launcher, e se si vuole lo si può saldare al launcher.



	If you would like to use the default SQLite [http://sqlite.org/]
database or you don’t know what this means then you can skip this step.
If you would like to use a database backend other than the default SQLite
backend then you will also need to install a database connector.

If you would like to use a PostgreSQL [http://www.postgresql.org]
database then activate the virtual environment and install psycopg2 with
the following commands:

source ~/.virtualenvs/ghide/bin/activate
pip install -U psycopg2





You might need solve dependencies. How to do so, depends on which GNU/Linux
flavour you are using. Check with your distribution documentation.





Next...

Connecting to a database.




Installing on MacOSX

Being MacOSX a unix environment, most things will work the same as on GNU/Linux
(sort of).

Last time we tested, some of the dependencies could not be installed on
MacOSX 10.5 and we assume similar problems would also show on older
OSX versions.  Ghini has been successfully tested with 10.7, 10.9 and 10.12.

First of all, you need things which are an integral part of a unix
environment, but which are missing in a off-the-shelf mac:


	developers tools: xcode. check the wikipedia page for the version
supported on your mac.

	package manager: homebrew (tigerbrew for older OSX versions).



with the above installed, open a terminal window and run:

brew doctor





make sure you understand the problems it reports, and correct them. pygtk
will need xquartz and brew will not solve the dependency
automatically. either install xquartz using brew or the way you prefer:

brew install Caskroom/cask/xquartz





then install the remaining dependencies:

brew install git
brew install pygtk  # takes time and installs all dependencies





follow all instructions on how to activate what you have installed.


Mac running OSX 10.12 —Sierra—

On OSX 10.12, brew reports that gettext is already
installed, but then it won’t let us find it. A solution is to run
the following line:

brew link gettext --force





Before we can run devinstall.sh as on GNU/Linux, we still
need installing a couple of python packages, globally. Do this:

sudo pip install virtualenv lxml







The rest is just as on a normal unix machine. Read the above GNU/Linux instructions, follow them, enjoy.

Next...

Connecting to a database.




Installing on Windows

The current maintainer of ghini.desktop has no interest in learning how to
produce Windows installers, so the Windows installation is here reduced to
the same installation procedure as on Unix (GNU/Linux and MacOSX).

Please report any trouble. Help with packaging will be very welcome, in
particular by other Windows users.

The steps described here instruct you on how to install Git, Gtk, Python,
and the python database connectors. With this environment correctly set up,
the Ghini installation procedure runs as on GNU/Linux. The concluding steps are
again Windows specific.


Nota

Ghini has been tested with and is known to work on W-XP, W-7 and
W-8. Although it should work fine on other versions Windows it has not
been thoroughly tested.




Nota

Direct download links are given for all needed components. They
have been tested in September 2015, but things change with
time. If any of the direct download links stops working, please
ring the bell, so we can update the information here.



The installation steps on Windows:


	download and install git (comes with a unix-like sh and includes
vi) from:

https://git-scm.com/download/win

Direct link to download git [https://github.com/git-for-windows/git/releases/download/v2.10.0.windows.1/Git-2.10.0-32-bit.exe]

all default options are fine, except we need git to be executable from
the command prompt:

[image: _images/git3.png]


	download and install Python 2.x (32bit) from:

http://www.python.org

Direct link to download Python [https://www.python.org/ftp/python/2.7.12/python-2.7.12.msi]

Ghini has been developed and tested using Python 2.x.  It will
definitely not run on Python 3.x.  If you are interested in helping
port to Python 3.x, please contact the Ghini maintainers.

when installing Python, do put Python in the PATH:

[image: _images/python3.png]


	download pygtk from the following source. (this requires 32bit
python). be sure you download the “all in one” version:

http://ftp.gnome.org/pub/GNOME/binaries/win32/pygtk/

Direct link to download PyGTK [http://ftp.gnome.org/pub/GNOME/binaries/win32/pygtk/2.24/pygtk-all-in-one-2.24.2.win32-py2.7.msi]

make a complete install, selecting everything:

[image: _images/pygtk1.png]


	(Windows 8.x) please consider this additional step. It is possibly
necessary to avoid the following error on Windows 8.1 installations:

Building without Cython.
ERROR: 'xslt-config' is not recognized as an internal or external command,
operable program or batch file.





If you skip this step and can confirm you get the error, please inform us.

You can download lxml from:

https://pypi.python.org/pypi/lxml/3.4.4





Remember you need the 32 bit version, for Python 2.7.

Direct link to download lxml [https://pypi.python.org/packages/2.7/l/lxml/lxml-3.6.0.win32-py2.7.exe]



	(optional) download and install a database connector other than
sqlite3.

On Windows, it is NOT easy to install psycopg2 from sources, using
pip, so “avoid the gory details” and use a pre-compiled pagkage from:

http://initd.org/psycopg/docs/install.html

Direct link to download psycopg2 [http://www.stickpeople.com/projects/python/win-psycopg/2.6.1/psycopg2-2.6.1.win32-py2.7-pg9.4.4-release.exe]



	REBOOT

hey, this is Windows, you need to reboot for changes to take effect!



	download and run (from \system32\cmd.exe) the batch file:


https://raw.githubusercontent.com/Ghini/ghini.desktop/master/scripts/devinstall.bat




right before you hit the enter key to run the script, your screen might
look like something like this:

[image: _images/sys32cmd-1.png]
this will pull the ghini.desktop repository on github to your home
directory, under Local\github\Ghini, checkout the ghini-1.0
production line, create a virtual environment and install ghini into it.

you can also run devinstall.bat passing it as argument the numerical
part of the production line you want to follow.

this is the last installation step that depends, heavily, on a working
internet connection.

the operation can take several minutes to complete, depending on the
speed of your internet connection.



	the last installation step creates the Ghini group and shortcuts in the
Windows Start Menu, for all users. To do so, you need run a script with
administrative rights. The script is called devinstall-finalize.bat,
it is right in your HOME folder, and has been created at the previous
step.

right-click on it, select run as administrator, confirm you want it to
make changes to your computer. These changes are in the Start Menu only:
create the Ghini group, place the Ghini shortcut.



	download the batch file you will use to stay up-to-date with the
production line you chose to follow:


https://raw.githubusercontent.com/Ghini/ghini.desktop/master/scripts/ghini-update.bat




if you are on a recent Ghini installation, each time you start the
program, Ghini will check on the development site and alert you of any
newer ghini release within your chosen production line.

any time you want to update your installation, just start the command
prompt and run ghini-update.bat





If you would like to generate and print PDF reports using Ghini’s
default report generator then you will need to download and install
Apache FOP [http://xmlgraphics.apache.org/fop/]. After extracting
the FOP archive you will need to include the directory you extracted
to in your PATH.

Next...

Connecting to a database.




Troubleshooting


	any error related to lxml.

In order to be able to compile lxml, you have to install a C compiler
(on GNU/Linux this would be the gcc package) and Cython (a Python
specialization, that gets compiled into C code. Note: Cython is not
CPython).

However, It should not be necessary to compile anything, and pip
should be able to locate the binary modules in the online libraries.

For some reason, this is not the case on Windows 8.1.

https://pypi.python.org/pypi/lxml/3.4.4

Please report any other trouble related to the installation of lxml.



	Couldn’t install gdata.

For some reason the Google’s gdata package lists itself in the
Python Package Index but doesn’t work properly with the
easy_install command.  You can download the latest gdata package
from:

http://code.google.com/p/gdata-python-client/downloads/list

Unzip it and run python setup.py installw in the folder you unzip it to.





Next...

Connecting to a database.







          

      

      

    

  

    
      
          
            
  
Initial Configuration

After a successful installation, more complex organizations will need
configure their database, and configure Ghini according to their database
configuration. This page focuses on this task. If you don’t know what this
is about, please do read the part relative to SQLite.


Should you SQLite?

Is this the first time you use Ghini, are you going to work in a
stand-alone setting, you have not the faintest idea how to manage a database
management system? If you answered yes to any of the previous, you probably
better stick with SQLite, the easy, fast, zero-administration file-based
database.

With SQLite, you do not need any preparation and you can continue with
connecting.

On the other hand, if you want to connect more than one bauble workstation
to the same database, or if you want to make your data available for other
clients, as could be a web server in a LAMP setting, you should consider
keeping your database in a database management system like PostgreSQL [http://www.postgresql.org] or MySQL/MariaDB [https://mariadb.org/],
both supported by Ghini.

When connecting to a database server as one of the above, you have to
manually create: at least one bauble user, the database you want bauble to
use, and to give at lest one bauble user full permissions on its
database. When this is done, Ghini will be able to proceed, creating the
tables and importing the default data set.  The process is
database-dependent and it falls beyond the scope of this manual.

If you already got the chills or sick at your stomach, no need to worry,
just stick with SQLite, you do not miss on features nor performance.




Connecting to a database

When you start Ghini the first thing that comes up is the connection
dialog.

Quite obviously, if this is the first time you start Ghini, you have no
connections yet and Ghini will alert you about it.

[image: _images/first-time-activation.png]
This alert will show at first activation and also in the future if your
connections list becomes empty. As it says: click on Add to create your
first connection.

[image: _images/enter-a-connection-name.png]
Just insert a name for your connection, something meaningful you associate
with the collection to be represented in the database (for example: “my home
garden”), and click on OK. You will be back to the previous screen, but
your connection name will be selected and the Connection Details will have
expanded.

[image: _images/my-first-botanical-garden.png]
specify the connection details

If you do not know what to do here, Ghini will help you stay safe. Activate the Use default locations check box and create your
first connection by clicking on Connect.

You may safely skip the remainder of this section for the time being and
continue reading to the following section.

fine-tune the connection details

By default Ghini uses the file-based SQLite database.  During the
installation process you had the choice (and you still have after
installation), to add database connectors other than the default SQLite.

In this example, Ghini can connect to SQLite, PostgreSQL and MySQL, but no
connector is available for Oracle or MS SQL Server.

[image: _images/connection-drop-down.png]
If you use SQLite, all you really need specify is the connection name. If
you let Ghini use the default filename then Ghini creates a database file
with the same name as the connection and .db extension, and a pictures
folder with the same name and no extension, both in ~/.bauble on
Linux/MacOSX or in AppData\Roaming\Bauble on Windows.

Still with SQLite, you might have received or downloaded a bauble database,
and you want to connect to it. In this case you do not let Ghini use the
default filename, but you browse in your computer to the location where you
saved the Ghini SQLite database file.

If you use a different database connector, the dialog box will look
different and it will offer you the option to fine tune all parameters
needed to connect to the database of your choice.

If you are connecting to an existing database you can continue to
Editing and Inserting Data and subsequently
Searching in Ghini, otherwise read on to the following section on
initializing a database for Ghini.

If you plan to associate pictures to plants, specify also the pictures
root folder. The meaning of this is explained in further detail at
Pictures in Editing and Inserting Data.




Initialize a database

First time you open a connection to a database which had never been seen by
Ghini before, Ghini will first display an alert:

[image: _images/empty-database.png]
immediately followed by a question:

[image: _images/bauble-create-new.png]
Be careful when manually specifying the connection parameters: the values
you have entered may refer to an existing database, not intended for use
with Ghini. By letting Ghini initialize a database, the database will be
emptied and all of its content be lost.

If you are sure you want to create a database at this connection then
select “Yes”. Ghini will then start creating the database tables and
importing the default data. This can take a minute or two so while all
of the default data is imported into the database so be patient.

Once your database has been created, configured, initialized, you are ready
to start Editing and Inserting Data and subsequently
Searching in Ghini.







          

      

      

    

  

    
      
          
            
  
Searching in Ghini

Searching allows you to view, browse and create reports from your
data. You can perform searches by either entering the queries in the
main search entry or by using the Query Builder to create the queries
for you. The results of Ghini searches are listed in the main window.


Search Strategies

Ghini offers four distinct search strategies:


	by value — in all domains;

	by expression — in a few implicit fields in one explicit domain;

	by query — in one domain;

	by binomial name — only searches the Species domain.



All search strategies —with the notable exception of the binomial name
search— are case insensitive.


Search by Value

Search by value is the simplest way to search. You enter one or more strings
and see what matches. The result includes objects of any type (domain) where
one or more of its fields contain one or more of the search strings.

You don’t specify the search domain, all are included, nor do you indicate
which fields you want to match, this is implicit in the search domain.

The following table helps you understand the results and guides you in
formulating your searches.








	search domain overview


	name and shorthands
	field
	result type




	family, fam
	epithet (family)
	Family


	genus, gen
	epithet (genus)
	Genus


	species, sp
	epithet (sp) ×
	Species


	vernacular, common, vern
	name
	Species


	geography, geo
	name
	Geography


	accession, acc
	code
	Accession


	planting, plant
	code ×
	Plant


	location, loc
	code, name
	Location


	contact, person, org, source
	name
	Contact


	collection, col, coll
	locale
	Collection


	tag, tags
	name
	Tag





Examples of searching by value would be: Maxillaria, Acanth,
2008.1234, 2003.2.1, indica.

Unless explicitly quoted, spaces separate search strings. For example if you
search for Block 10 then Ghini will search for the strings Block and 10
and return all the results that match either of these strings. If you want
to search for Block 10 as one whole string then you should quote the string
like "Block 10".


× Composite Primary Keys


A species epithet means little without the corresponding
genus, likewise a planting code is unique only within
the accession to which it belongs.  In database theory
terminology, epithet and code are not sufficient to form a
primary key for respectively species and planting.
These domains need a composite primary key.

Search by value lets you look for plantings by their
complete planting code, which includes the accession code.
Taken together, Accession code and Planting code do provide
a composite primary key for plantings.  For species,
we have introduced the binomial search, described below.









Search by Expression

Searching with expression gives you a little more control over what you are
searching for. You narrow the search down to a specific domain, the software
defines which fields to search within the domain you specified.

An expression is built as <domain> <operator> <value>. For example the
search: gen=Maxillaria would return all the genera that match the name
Maxillaria. In this case the domain is gen, the operator is = and
the value is Maxillaria.

The above search domain overview table tells you the names of the search
domains, and, per search domain, which fields are searched.

The search string loc like block% would return all the Locations for
which name or code start with “block”.  In this case the domain is loc
(a shorthand for location), the operator is like (this comes from
SQL and allows for “fuzzy” searching), the value is block%, the
implicitly matched fields are name and code.  The percent sign is
used as a wild card so if you search for block% then it searches for all
values that start with max.  If you search for %10 it searches for all
values that end in 10.  The string %ck%10 would search for all value
that contain ck and end in 10.


When a query takes ages to complete

You give a query, it takes time to compute, the result contains
unreasonably many entries.  This happens when you intend to use a
strategy, but your strings do not form a valid expression.  In this case
Ghini falls back to search by value. For example the search string
gen lik maxillaria will search for the strings gen, lik, and
maxillaria, returning all that match at least one of the three
criteria.






Binomial search

You can also perform a search in the database if you know the species, just
by placing a few initial letters of genus and species epithets in the search
engine, correctly capitalized, i.e.: Genus epithet with one leading capital
letter, Species epithet all lowercase.

This way you can perform the search So ha.

These would be the initials for Solanum hayesii, or Solanum havanense.

Binomial search comes to compensate the limited usefulness of the above
search by expression when trying to look for a species.

It is the correct capitalization Xxxx xxxx that informs the
software of your intention to perform a binomial search.  The software’s
second guess will be a search by value, which will possibly result in far
more matches than you had expected.

The similar request so ha will return, in a fresh install, over 3000
objects, starting at Family “Acalyp(ha)ceae”, ending at Geography
“Western (So)uth America”.




Search by Query

Queries allow the most control over searching. With queries you can search
across relations, specific columns, combine search criteria using boolean
operators like and, or, not (and their shorthands &&,
||, !), enclose them in parentheses, and more.

Please contact the authors if you want more information, or if you volunteer
to document this more thoroughly.  In the meanwhile you may start
familiarizing yourself with the core structure of Ghini’s database.


[image: _images/ghini-10.svg]core structure of Ghini’s database



A few examples:


	plantings of family Fabaceae in location Block 10:

plant WHERE accession.species.genus.family.epithet=Fabaceae AND location.description="Block 10"







	locations that contain no plants:

location WHERE plants = Empty







	accessions associated to a species of known binomial name (e.g.: Mangifera indica):

accession WHERE species.genus.epithet=Mangifera AND species.epithet=indica







	accessions we propagated in the year 2016:

accession WHERE plants.propagations._created BETWEEN |datetime|2016,1,1| AND |datetime|2017,1,1|







	accessions we modified in the last three days:

accession WHERE _last_updated>|datetime|-3|









Searching with queries requires some knowledge of a little syntax and an
idea of the extensive Ghini database table structure. Both you acquire with
practice, and with the help of the Query Builder.






The Query Builder

Ghini offers a Query Builder, that helps you build complex search queries
through a point and click interface.  To open the Query Builder click the
[image: querybuilder] icon to the left of the search entry or select
Tools‣Query Builder from the menu.

A window will show up, which will lead you through all steps necessary to
construct a correct query that is understood by Ghini’s Query Search
Strategy.


[image: _images/qb-choose_domain.png]


[image: _images/qb-choose_property.png]
First of all you indicate the search domain, this will allow the Query
Builder complete its graphical user interface, then you add as many logical
clauses as you need, connecting them with a and or or binary
operator.

Each clause is formed of three parts: a property that can be reached from
the starting search domain, a comparison operator that you select from the
drop-down list, a value that you can either type or select from the list of
valid values for the field.

Add as many search properties as you need, by clicking on the plus sign.
Select and/or next to the property name to choose how the clauses will be
combined in the search query.

When you are done building your query click OK to perform the search.




Query Grammar

For those who don’t fear a bit of formal precision, the following BNF code
gives you a rather precise idea of the grammar implemented by the Query
Search Strategy.  Some grammatical categories are informally defined; any
missing ones are left to your fertile imagination; literals are included in
single quotes; the grammar is mostly case insensitive, unless otherwise
stated:

query ::= domain 'WHERE' expression

domain ::= #( one of our search domains )
expression ::= signed_clause
             | signed_clause 'AND' expression
             | signed_clause 'OR' expression
             ;
signed_clause ::= clause
                | 'NOT' clause  #( not available in Query Builder)
                ;
clause ::= field_name binop value  #( available in Query Builder)
         | field_name set_binop value_list
         | aggregated binop value
         | field_name 'BETWEEN' value 'AND' value
         | '(' expression ')'
         ;
field_name ::= #( path to reach a database field or connected table )
aggregated ::= aggregating_func '(' field_name ')'
aggregating_func ::= 'SUM'
                   | 'MIN'
                   | 'MAX'
                   | 'COUNT'
                   ;
value ::= typed_value
        | numeric_value
        | none_token
        | empty_token
        | string_value
        ;
typed_value ::= '|' type_name '|' value_list '|'
numeric_value ::== #( just a number )
none_token ::= 'None'    #( case sensitive )
empty_token ::= 'Empty'  #( case sensitive )
string_value = quoted_string | unquoted_string

type_name ::= 'datetime' | 'bool' ;  #( only ones for the time being )
quoted_string ::= '"' unquoted_string '"'
unquoted_string ::=  #( alphanumeric and more )

value_list ::= value ',' value_list
             | value
             ;
binop ::= '='
        | '=='
        | '!='
        | '<>'
        | '<'
        | '<='
        | '>'
        | '>='
        | 'LIKE'
        | 'CONTAINS'
        ;
set_binop ::= 'IN'





Please be aware that Ghini’s Query language is quite a bit more complex than
what the Query Builder can produce: Queries you can build with the Query
Builder form a proper subset of the queries recognized by the software:

query ::= domain 'WHERE' expression

domain ::= #( one of our search domains )
expression ::= clause
             | clause 'AND' expression
             | clause 'OR' expression
             ;
clause ::= field_name binop value
         ;
field_name ::= #( path to reach a database field or connected table )
value ::= numeric_value
        | string_value
        ;
numeric_value ::== #( just a number )
string_value = quoted_string | unquoted_string ;

quoted_string ::= '"' unquoted_string '"'
unquoted_string ::=  #( alphanumeric and more )

binop ::= '='
        | '=='
        | '!='
        | '<>'
        | '<'
        | '<='
        | '>'
        | '>='
        | 'LIKE'
        | 'CONTAINS'
        ;











          

      

      

    

  

    
      
          
            
  
Editing and Inserting Data

The main way that we add or change information in Ghini is by using
the editors.  Each basic type of data has its own editor.  For example
there is a Family editor, a Genus editor, an Accession editor, etc.

To create a new record click on the Insert menu on
the menubar and then select the type of record your would like to
create.  This opens a new blank editor for the type.

To edit an existing record in the database right click on an item in
the search results and select Edit from the popup
menu.  This opens an editor that allows you to change the
values on the record that you selected.

Most types also have children which you can add by right clicking on the
parent and selecting “Add ???...” on the context menu.  For example, a
Family has Genus children: you can add a Genus to a Family by right clicking
on a Family and selecting “Add genus”.


Notes

Almost all of the editors in Ghini have a Notes tab which should work
the same regardless of which editor you are using.

If you enter a web address in a note then the link shows up in the
Links box when the item your are editing is selected in the search results.

You can browse the notes for an item in the database using the Notes
box at the bottom of the screen.  The Notes box is desensitized
if the selected item does not have any notes.




Family

The Family editor allows you to add or change a botanical family.

The Family field on the editor lets you change the epithet of the family.
The Family field is required.

The Qualifier field lets you change the family qualifier.  The value can
either be sensu lato, sensu stricto, or nothing.

Synonyms allow you to add other families that are synonyms with the family
you are currently editing.  To add a new synonyms type in a family name in
the entry.  You must select a family name from the list of completions.
Once you have selcted a family name that you want to add as a synonym click
on the Add button next to the synonym list and the software adds the
selected synonym to the list.  To remove a synonym, select the synonym from
the list and click on the Remove button.

To cancel your changes without saving then click on the Cancel button.

To save the family you are working on then click OK.

To save the family you are working on and add a genus to it then click on
the Add Genera button.

To add another family when you are finished editing the current one
click on the Next button on the bottom.  This saves the current
family and opens a new blank family editor.




Genus

The Genus editor allows you to add or change a botanical genus.

The Family field on the genus editor allows you to choose the family
for the genus.  When you begin type a family name it will show a list
of families to choose from.  The family name must already exist in the
database before you can set it as the family for the genus.

The Genus field allows you to set the genus for this entry.

The Author field allows you to set the name or abbreviation of the
author(s) for the genus.

Synonyms allow you to add other genera that are synonyms with the
genus you are currently editing.  To add a new synonyms type in a
genus name in the entry.  You must select a genus name from the list
of completions.  Once you have selcted a genus name that you want to
add as a synonym click on the Add button next to the synonym list and
it will add the selected synonym to the list.  To remove a synonym
select the synonym from the list and click on the Remove button.

To cancel your changes without saving then click on the Cancel button.

To save the genus you are working on then click OK.

To save the genus you are working on and add a species to it then click on
the Add Species button.

To add another genus when you are finished editing the current one
click on the Next button on the bottom.  This will save the current
genus and open a new blank genus editor.




Species/Taxon

For historical reasons called a species, but by this we mean a taxon at
rank species or lower.  It represents a unique name in the database.  The
species editor allows you to construct the name as well as associate
metadata with the taxon such as its distribution, synonyms and other
information.

The Infraspecific parts in the species editor allows you to specify
the taxon further than at species rank.

To cancel your changes without saving then click on the Cancel button.

To save the species you are working on then click OK.

To save the species you are working on and add an accession to it then click on
the Add Accession button.

To add another species when you are finished editing the current one
click on the Next button on the bottom.  This will save the current
species and open a new blank species editor.




Accessions

The Accession editor allows us to add an accession to a species.  In
Ghini an accession represents a group of plants or clones.  The
accession would refer maybe a group of seed or cuttings from a
species.  A plant would be an individual from that accesssion, i.e. a
specific plant in a specific location.


Accession Source

The source of the accessions lets you add more information about where
this accession came from.  At the moment the type of the source can be
either a Collection or a Donation.


Collection

A Collection.




Donation

A Donation.








Plant

The Plant editor.


Creating multiple plants

You can create multiple Plants by using ranges in the code entry.
This is only allowed when creating new plants and it is not possible
when editing existing Plants in the database.

For example the range, 3-5 will create plant with code 3,4,5.  The
range 1,4-7,25 will create plants with codes 1,4,5,6,7,25.

When you enter the range in the plant code entry the entry will turn
blue to indicate that you are now creating multiple plants.  Any
fields that are set while in this mode will be copied to all the
plants that are created.




Pictures

Just as almost all objects in the Ghini database can have Notes
associated to them, Plants can have Pictures: next to the tab for Notes,
the Plants editor contains an extra tab called “Pictures”. You can associate
as many pictures as you might need to a plant.

When you associate a picture to a plant, the file is copied in the
pictures folder, and a miniature (500x500) is generated and copied in the
thumbnails folder inside of the pictures folder.

As of Ghini-1.0.62, Pictures are not kept in the database. To ensure
pictures are available on all terminals where you have installed and
configured Ghini, you can use a file sharing service like Copy or
Dropbox. The personal choice of the writer of this document is to use Copy,
because it offers much more space and because of its “Fair Storage” policy.

Remember that you have configured the pictures root folder when you
specified the details of your database connection. Again, you should make
sure that the pictures root folder is shared with your file sharing service
of choice.

When a Plant in the current selection is highlighted, its pictures are
displayed in the pictures pane, the pane left of the information pane. When
an accession in the selection is highlighted, any picture associated to the
plants in the highlighted accession are displayed in the pictures pane.






Locations

The Location editor


danger zone

The location editor contains an initially hidden section named danger
zone. The widgets contained in this section allow the user to merge the
current location into a different location, letting the user correct
spelling mistakes or implement policy changes.









          

      

      

    

  

    
      
          
            
  
Dealing with Propagations

Ghini offers the possibility to associate Propagations trials to Plants and
to document their treatments and results. Treatments are integral parts of
the description of a Propagation trial. If a Propagation trial is
successful, Ghini lets you associate it to a new Accession. You can only
associate one Accession to a Propagation Trial.

Here we describe how you use this part of the interface.


Creating a Propagation

A Propagation (trial) is obtained from a Plant. Ghini reflects this in its
interface: you select a plant, open the Plant Editor on it, activate the
Propagation Tab, click on Add.

When you do the above, you get a Propagation Editor window. Ghini does not
consider Propagation trials as independent entities. As a result, Ghini
treats the Propagation Editor as a special editor window, which you can only
reach from the Plant Editor.

For a new Propagation, you select the type of propagation (this becomes an
immutable property of the propagation) then insert the data describing it.

You will be able to edit the propagation data via the same path: select a
plant, open the Plant Editor, identify the propagation you want to edit,
click on the corresponding Edit button. You will be able to edit all
properties of an existing Propagation trial, except its type.

In the case of a seed propagation trial, you have a pollen parent, and a
seed parent. You should always associate the Propagation trial to the seed
parent.


Nota

In Ghini-1.0 you specify the pollen parent plant in the “Notes”
field, while Ghini-1.1 has a (relation) field for it. According to
ITF2, there might be cases in seed propagation trials where it is
not known which Plant plays which role. Again, in Ghini-1.0 you
should use a note to indicate whether this is the case, Ghini-1.1
has a (boolean) field indicating whether this is the case.






Using a Propagation

A Propagation trial may be successful and result in a new Accession.

Ghini helps you reflect this in the database: create a new Accession,
immediately switch to the Source tab and select “Garden Propagation” in the
(admittedly somewhat misleading) Contact field.

Start typing the plant number and a list of matching plants with propagation
trials will appear for you to select from.

Select the plant, and the list of accessed and unaccessed propagation trials
will appear in the lower half of the window.

Select a still unaccessed propagation trial from the list and click on Ok to
complete the operation.

Using the data from the Propagation trial, Ghini completes some of the
fields in the General tab: Taxon name, Type of material, and possibly
Provenance. You will be able to edit these fields, but please note that the
software will not prevent introducing conceptual inconsistencies in your
database.

You can associate a Propagation trial to only one Accession.







          

      

      

    

  

    
      
          
            
  
Tagging

Tagging is an easy way to give context to an object or create a
collection of object that you want to recall later. For example if you
want to collect a bunch of plants that you later want to create a
report from you can tag them with the string “for that report i was
thinking about”. You can then select “for that report i was thinking
about” from the tags menu to show you all the objects you tagged.

Tagging can be done two ways. By selecting one or more items in the
search results and pressing Ctrl-T or by selecting
Tag‣Tag Selection from the menu. If you have
selected multiple items then only that tags that are common to all the
selected items will have a check next to it.





          

      

      

    

  

    
      
          
            
  
Generating reports

A database without exporting facilities is of little use. Ghini lets you
export your data in table format (open them in your spreadsheet editor of
choice), as labels (to be printed or engraved), as html pages or pdf or
postscript documents.

This page describes the two tools Ghini offers for these tasks.


Using the Mako Report Formatter

The Mako report formatter uses the Mako template language for
generating reports. More information about Mako and its language can
be found at makotemplates.org [http://www.makotemplates.org].

The Mako templating system should already be installed on your
computer if Ghini is installed.

Creating reports with Mako is similar in the way that you would create
a web page from a template.  It is much simpler than the XSL
Formatter(see below) and should be relatively easy to create template
for anyone with a little but of programming experience.

The template generator will use the same file extension as the
template which should indicate the type of output the template with
create.  For example, to generate an HTML page from your template you
should name the template something like report.html.  If the template
will generate a comma seperated value file you should name the
template report.csv.

The template will receive a variable called values which will
contain the list of values in the current search.

The type of each value in values will be the same as the search
domain used in the search query.  For more information on search
domains see search-domains.

If the query does not have a search domain then the values could all
be of a different type and the Mako template should prepared to handle
them.




Using the XSL Report Formatter

The XSL report formatter requires an XSL to PDF renderer to
convert the data to a PDF file. Apache FOP is is a free and
open-source XSL->PDF renderer and is recommended.

If using Linux, Apache FOP should be installable using your package
manager.  On Debian/Ubuntu it is installable as fop in Synaptic or
using the following command:

apt-get install fop






Installing Apache FOP on Windows

You have two options for installing FOP on Windows. The easiest way is
to download the prebuilt ApacheFOP-0.95-1-setup.exe [http://code.google.com/p/apache-fop-installer/downloads/detail?name=ApacheFOP-0.95-1-setup.exe&can=2&q=#makechanges] installer.

Alternatively you can download the archive [http://www.apache.org/dist/xmlgraphics/fop/binaries/].  After
extracting the archive you must add the directory you extracted the
archive to to your PATH environment variable.









          

      

      

    

  

    
      
          
            
  
Importing and Exporting Data

Although Ghini can be extended through plugins to support alternate
import and export formats, by default it can only import and export
comma seperated values files or CSV.

There is some support for exporting to the Access for Biological
Collections Data it is limited.

There is also limited support for exporting to an XML format that more
or less reflects exactly the tables and row of the database.

Exporting ABCD and XML will not be covered here.


Avvertimento

Importing files will most likely destroy any data you
have in the database so make sure you have backed up your data.




Importing from CSV

In general it is best to only import CSV files into Ghini that were
previously exported from Ghini. It is possible to import any CSV file
but that is more advanced that this doc will cover.

To import CSV files into Ghini select
Tools‣Export‣Comma Seperated Values from the
menu.

After clicking OK on the dialog that ask if you are sure you know what
you’re doing a file chooser will open.  In the file chooser select the
files you want to import.




Exporting to CSV

To export the Ghini data to CSV select
Tools‣Export‣Comma Seperated Values from the menu.

This tool will ask you to select a directory to export the CSV data.
All of the tables in Ghini will be exported to files in the format
tablename.txt where tablename is the name of the table where the data
was exported from.




Importing from JSON

This is the way to import data into an existing database, without
destroying previous content. A typical example of this functionality would
be importing your digital collection into a fresh, just initialized Ghini
database. Converting a database into bauble json interchange format is
beyond the scope of this manual, please contact one of the authors if you
need any further help.

Using the Ghini json interchange format, you can import data which you have
exported from a different Ghini installation.




Exporting to JSON

This feature is still under development.

[image: _images/export-to-json.png]
when you activate this export tool, you are given the choice to specify what
to export. You can use the current selection to limit the span of the
export, or you can start at the complete content of a domain, to be chosen
among Species, Accession, Plant.

Exporting Species will only export the complete taxonomic information in
your database. Accession will export all your accessions plus all the
taxonomic information it refers to: unreferred to taxa will not be
exported. Plant will export all living plants (some accession might not be
included), all referred to locations and taxa.







          

      

      

    

  

    
      
          
            
  
Managing Users


Nota

The Ghini users plugin is only available on PostgreSQL
based databases.



The Ghini User’s Plugin will allow you to create and manage the
permissions of users for your Ghini database.


Creating Users

To create a new user...




Permissions

Ghini allows read, write and execute permissions.







          

      

      

    

  

    
      
          
            
  
Database Administration

Nel caso si stia utilizzando un vero e proprio DBMS (sistema di gestione di basi di dati) per contenere le collezioni di Bauble, è importante prendere in considerazione l’amministrazione di questo DBMS. Una descrizione del compito di amministrare una base dati è qui assolutamente fuori luogo, ma è importante che un utente sia consapevole del problema.


SQLite

SQLite offre una soluzione in quanto SQLite non è esattamente quanto si potrebbe definire un DMBS: ogni base dati SQLite è un file, farne copia di emergenza (backup) sarà sufficiente. Se si è creata la connessione alla base dati SQLite accettando i valori per difetto, il file relativo alla connessione si trova nella directory ~/.bauble/ (con Windows bisognerà trovare la AppData).

In Windows it is somewhere in your AppData directory, most likely in
AppData\Roaming\Bauble. Do keep in mind that Windows does its best to
hide the AppData directory structure to normal users.

The fastest way to open it is with the file explorer: type ``%APPDATA%` and
hit enter.




MySQL

Prego riferirsi alla documentazione ufficiale.




PostgreSQL

Prego riferirsi alla documentazione ufficiale. Una discussione molto approfondita sulle varie opzioni di backup inizia al chapter_24 [http://www.postgresql.org/docs/9.1/static/backup.html].






Ghini Configuration

Ghini uses a configuration file to store values across invocations. This
file is associated to a user account and every user will have their own
configuration file.

To review the content of the Ghini configuration file, type :prefs in
the text entry area where you normally type your searches, then hit enter.

You normally do not need tweaking the configuration file, but you can do so
with a normal text editor program. Ghini configuration file is at the
default location for SQLite databases.




Reporting Errors

Should you notice anything unexpected in Ghini’s behaviour, please consider
filing an issue on the Ghini development site.

Ghini development site can be accessed via the Help menu.





          

      

      

    

  

    
      
          
            
  
Developer’s Manual


Helping Ghini development

Installing Ghini always includes downloading the sources, connected to the
github repository. This is so because in our eyes, every user is always
potentially also a developer.

If you want to contribute to Ghini, you can do so in quite a few different ways:



	Use the software, note the things you don’t like, open an issue [http://github.com/Ghini/ghini.desktop/issues/new] for each of them. A
developer will react sooner than you can imagine.

	If you have an idea of what you miss in the software but can’t quite
formalize it into separate issues, you could consider hiring a
professional. This is the best way to make sure that something happens
quickly on Ghini. Do make sure the developer opens issues and publishes
their contribution on github.

	Translate! Any help with translations will be welcome, so please do! you
can do this without installing anything on your computer, just using the
on-line translation service offered by http://hosted.weblate.org/

	fork the respository, choose an issue, solve it, open a pull request. See
the bug solving workflow below.






If you haven’t yet installed Ghini, and want to have a look at its code
history, you can open our github project page [http://github.com/Ghini/ghini.desktop] and see all that has been going on
around Ghini since its inception as Bauble, back in the year 2004.




Software source, versions, branches

If you want a particular version of Ghini, we release and maintain versions
as branches. You should git checkout the branch corresponding to the
version of your choice.


production line

Branch names for Ghini stable (production) versions are of the form
ghini-x.y (eg: ghini-1.0); branch names where Ghini testing versions are
published are of the form ghini-x.y-dev (eg: ghini-1.0-dev).






Development Workflow

Our workflow is to continuously commit to the testing branch, to often push
them to github, to let travis-ci and coveralls.io check the quality of the
pushed testing branches, finally, from time to time, to merge the testing
branch into the corresponding release.

When working at larger issues, which seem to take longer than a couple of
days, I might open a branch associated to the issue. I don’t do this very
often.


larger issues

When facing a single larger issue, create a branch tag at the tip of a main
development line (e.g.: ghini-1.0-dev), and follow the workflow
described at

https://git-scm.com/book/en/v2/Git-Branching-Basic-Branching-and-Merging

in short:

git up
git checkout -b issue-xxxx
git push origin issue-xxxx





Work on the new temporary branch. When ready, go to github, merge the branch
with the main development line from which you branched, solve conflicts
where necessary, delete the temporary branch.

When ready for publication, merge the development line into the
corresponding production line.






Updating the set of translatable strings

From time to time, during the process of updating the software, you will be
adding or modifying strings in the python sources, in the documentation, in
the glade sources. Most of our strings are translatable, and are offered to
weblate for people to contribute, in the form of several .po
files. These po files receive contributions from weblate, and offer
lines without translation from new lines of code.

We have organized the translation of ghini as two separate repositories in
github, each repository being associated to sections of the same project on
weblate. Translation of the software is in ghini.desktop, the software
project, while translation of the documentation —itself part of the
software— is in a separate project, ghini.desktop-docs.i18n.

To update the po files relative to the software, you run a script from
the project root dir:

./scripts/i18n.sh





This will update your po files, something you need commit and push to
github.

We haven’t yet defined a workflow for publishing translated documentation on
readthedocs. If you have experience with it please have a go at it. Thank
you in advance.




Adding missing unit tests

If you are interested contributing to development of Ghini, a good way to
do so would be by helping us finding and writing the missing unit tests.

A well tested function is one whose behaviour you cannot change without
breaking at least one unit test.

We all agree that in theory theory and practice match perfectly and that one
first writes the tests, then implements the function. In practice, however,
practice does not match theory and we have been writing tests after writing
and even publishing the functions.

This section describes the process of adding unit tests for
bauble.plugins.plants.family.remove_callback.


What to test

First of all, open the coverage report index, and choose a file with low
coverage.

For this example, run in October 2015, we landed on
bauble.plugins.plants.family, at 33%.

https://coveralls.io/builds/3741152/source?filename=bauble%2Fplugins%2Fplants%2Ffamily.py

The first two functions which need tests, edit_callback and
add_genera_callback, include creation and activation of an object
relying on a custom dialog box. We should really first write unit tests for
that class, then come back here.

The next function, remove_callback, also activates a couple of dialog
and message boxes, but in the form of invoking a function requesting user
input via yes-no-ok boxes. These functions we can easily replace with a
function mocking the behaviour.




how to test

So, having decided what to describe in unit test, we look at the code and we
see it needs discriminate a couple of cases:


	parameter correctness

	
	the list of families has no elements.

	the list of families has more than one element.

	the list of families has exactly one element.





	cascade

	
	the family has no genera

	the family has one or more genera





	confirm

	
	the user confirms deletion

	the user does not confirm deletion





	deleting

	
	all goes well when deleting the family

	there is some error while deleting the family







I decide I will only focus on the cascade and the confirm
aspects. Two binary questions: 4 cases.




where to put the tests

Locate the test script and choose the class where to put the extra unit tests.

https://coveralls.io/builds/3741152/source?filename=bauble%2Fplugins%2Fplants%2Ftest.py#L273


Nota

The FamilyTests class contains a skipped test, implementing it
will be quite a bit of work because we need rewrite the
FamilyEditorPresenter, separate it from the FamilyEditorView and
reconsider what to do with the FamilyEditor class, which I think
should be removed and replaced with a single function.






writing the tests

After the last test in the FamilyTests class, I add the four cases I want to
describe, and I make sure they fail, and since I’m lazy, I write the most
compact code I know for generating an error:

def test_remove_callback_no_genera_no_confirm(self):
    1/0

def test_remove_callback_no_genera_confirm(self):
    1/0

def test_remove_callback_with_genera_no_confirm(self):
    1/0

def test_remove_callback_with_genera_confirm(self):
    1/0








One test, step by step

Let’s start with the first test case.

When writing tests, I generally follow the pattern:


	T₀ (initial condition),

	action,

	T₁ (testing the result of the action given the initial conditions)




Nota

There’s a reason why unit tests are called unit tests. Please
never test two actions in one test.



So let’s describe T₀ for the first test, a database holding a family without
genera:

def test_remove_callback_no_genera_no_confirm(self):
    f5 = Family(family=u'Arecaceae')
    self.session.add(f5)
    self.session.flush()





We do not want the function being tested to invoke the interactive
utils.yes_no_dialog function, we want remove_callback to invoke a
non-interactive replacement function. We achieve this simply by making
utils.yes_no_dialog point to a lambda expression which, like the
original interactive function, accepts one parameter and returns a
boolean. In this case: False:

def test_remove_callback_no_genera_no_confirm(self):
    # T_0
    f5 = Family(family=u'Arecaceae')
    self.session.add(f5)
    self.session.flush()

    # action
    utils.yes_no_dialog = lambda x: False
    from bauble.plugins.plants.family import remove_callback
    remove_callback(f5)





Next we test the result.

Well, we don’t just want to test whether or not the object Arecaceae was
deleted, we also should test the value returned by remove_callback, and
whether yes_no_dialog and message_details_dialog were invoked or
not.

A lambda expression is not enough for this. We do something apparently
more complex, which will make life a lot easier.

Let’s first define a rather generic function:

def mockfunc(msg=None, name=None, caller=None, result=None):
    caller.invoked.append((name, msg))
    return result





and we grab partial from the functools standard module, to partially
apply the above mockfunc, leaving only msg unspecified, and use this
partial application, which is a function accepting one parameter and
returning a value, to replace the two functions in utils. The test
function now looks like this:

def test_remove_callback_no_genera_no_confirm(self):
    # T_0
    f5 = Family(family=u'Arecaceae')
    self.session.add(f5)
    self.session.flush()
    self.invoked = []

    # action
    utils.yes_no_dialog = partial(
        mockfunc, name='yes_no_dialog', caller=self, result=False)
    utils.message_details_dialog = partial(
        mockfunc, name='message_details_dialog', caller=self)
    from bauble.plugins.plants.family import remove_callback
    result = remove_callback([f5])
    self.session.flush()





The test section checks that message_details_dialog was not invoked,
that yes_no_dialog was invoked, with the correct message parameter, that
Arecaceae is still there:

# effect
self.assertFalse('message_details_dialog' in
                 [f for (f, m) in self.invoked])
self.assertTrue(('yes_no_dialog', u'Are you sure you want to '
                 'remove the family <i>Arecaceae</i>?')
                in self.invoked)
self.assertEquals(result, None)
q = self.session.query(Family).filter_by(family=u"Arecaceae")
matching = q.all()
self.assertEquals(matching, [f5])








And so on


there are two kinds of people, those who complete what they start, and
so on


Next test is almost the same, with the difference that the
utils.yes_no_dialog should return True (this we achieve by
specifying result=True in the partial application of the generic
mockfunc).

With this action, the value returned by remove_callback should be
True, and there should be no Arecaceae Family in the database any more:

def test_remove_callback_no_genera_confirm(self):
    # T_0
    f5 = Family(family=u'Arecaceae')
    self.session.add(f5)
    self.session.flush()
    self.invoked = []

    # action
    utils.yes_no_dialog = partial(
        mockfunc, name='yes_no_dialog', caller=self, result=True)
    utils.message_details_dialog = partial(
        mockfunc, name='message_details_dialog', caller=self)
    from bauble.plugins.plants.family import remove_callback
    result = remove_callback([f5])
    self.session.flush()

    # effect
    self.assertFalse('message_details_dialog' in
                     [f for (f, m) in self.invoked])
    self.assertTrue(('yes_no_dialog', u'Are you sure you want to '
                     'remove the family <i>Arecaceae</i>?')
                    in self.invoked)
    self.assertEquals(result, True)
    q = self.session.query(Family).filter_by(family=u"Arecaceae")
    matching = q.all()
    self.assertEquals(matching, [])





have a look at commit 734f5bb9feffc2f4bd22578fcee1802c8682ca83 for the other
two test functions.




Testing logging

Our bauble.test.BaubleTestCase objects use handlers of the class
bauble.test.MockLoggingHandler.  Every time an individual unit test is
started, the setUp method will create a new handler and associate it
to the root logger.  The tearDown method takes care of removing it.

You can check for presence of specific logging messages in
self.handler.messages. messages is a dictionary, initially empty,
with two levels of indexation. First the name of the logger issuing the
logging record, then the name of the level of the logging record. Keys are
created when needed. Values hold lists of messages, formatted according to
whatever formatter you associate to the handler, defaulting to
logging.Formatter("%(message)s").

You can explicitly empty the collected messages by invoking
self.handler.clear().




Putting all together

From time to time you want to activate the test class you’re working at:

nosetests bauble/plugins/plants/test.py:FamilyTests





And at the end of the process you want to update the statistics:

./scripts/update-coverage.sh










Structure of user interface

The user interface is built according to the Model — View —
Presenter architectural pattern.  For much of the interface, Model
is a SQLAlchemy database object, but we also have interface elements where
there is no corresponding database model.  In general:


	The View is described as part of a glade file. This should include
the signal-callback and ListStore-TreeView associations. Just reuse the
base class GenericEditorView defined in bauble.editor. When you
create your instance of this generic class, pass it the glade file
name and the root widget name, then hand this instance over to the
presenter constructor.

In the glade file, in the action-widgets section closing your
GtkDialog object description, make sure every action-widget element
has a valid response value.  Use valid GtkResponseType values [http://gtk.php.net/manual/en/html/gtk/gtk.enum.responsetype.html], for
example:


	GTK_RESPONSE_OK, -5

	GTK_RESPONSE_CANCEL, -6

	GTK_RESPONSE_YES, -8

	GTK_RESPONSE_NO, -9



There is no easy way to unit test a subclassed view, so please don’t
subclass views, there’s really no need to.

In the glade file, every input widget should define which handler is
activated on which signal.  The generic Presenter class offers generic
callbacks which cover the most common cases.


	GtkEntry (one-line text entry) will handle the changed signal, with
either on_text_entry_changed or on_unique_text_entry_changed.

	GtkTextView: associate it to a GtkTextBuffer. To handle the changed
signal on the GtkTextBuffer, we have to define a handler which invokes
the generic on_textbuffer_changed, the only role for this function
is to pass our generic handler the name of the model attribute that
receives the change. This is a workaroud for an unresolved bug in GTK [http://stackoverflow.com/questions/32106765/].

	GtkComboBox with translated texts can’t be easily handled from the glade
file, so we don’t even try.  Use the init_translatable_combo method
of the generic GenericEditorView class, but please invoke it from
the presenter.





	The Model is just an object with known attributes. In this
interaction, the model is just a passive data container, it does
nothing more than to let the presenter modify it.



	The subclassed Presenter defines and implements:


	widget_to_field_map, a dictionary associating widget names to name
of model attributes,

	view_accept_buttons, the list of widget names which, if
activated by the user, mean that the view should be closed,

	all needed callbacks,

	optionally, it plays the model role, too.



The presenter continuously updates the model according to changes
in the view. If the model corresponds to a database object, the
presenter commits all model updates to the database when the
view is closed successfully, or rolls them back if the view is
canceled. (this behaviour is influenced by the parameter do_commit)

If the model is something else, then the presenter will do
something else.


Nota

A well behaved presenter uses the view api to query the values
inserted by the user or to forcibly set widget statuses. Please do not
learn from the practice of our misbehaving presenters, some of which
directly handle fields of view.widgets. By doing so, these
presenters prevents us from writing unit tests.







The base class for the presenter, GenericEditorPresenter defined in
bauble.editor, implements many useful generic callbacks.  There is a
MockView class, that you can use when writing tests for your presenters.


Examples

Contact and ContactPresenter are implemented following the above
lines.  The view is defined in the contact.glade file.

A good example of Presenter/View pattern (no model) is given by the
connection manager.

We use the same architectural pattern for non-database interaction, by
setting the presenter also as model. We do this, for example, for the JSON
export dialog box. The following command will give you a list of
GenericEditorView instantiations:

grep -nHr -e GenericEditorView\( bauble










Extending Ghini with Plugins

Nearly everything about Ghini is extensible through plugins. Plugins
can create tables, define custom searchs, add menu items, create
custom commands and more.

To create a new plugin you must extend the bauble.pluginmgr.Plugin
class.

The Tag plugin is a good minimal example, even if the TagItemGUI
falls outside the Model-View-Presenter architectural pattern.




Plugins structure

Ghini is a framework for handling collections, and is distributed along
with a set of plugins making Ghini a botanical collection manager. But
Ghini stays a framework and you could in theory remove all plugins we
distribute and write your own, or write your own plugins that extend or
complete the current Ghini behaviour.

Once you have selected and opened a database connection, you land in the
Search window. The Search window is an interaction between two objects:
SearchPresenter (SP) and SearchView (SV).

SV is what you see, SP holds the program status and handles the requests you
express through SV. Handling these requests affect the content of SV and the
program status in SP.

The search results shown in the largest part of SV are rows, objects that
are instances of classes registered in a plugin.

Each of these classes must implement an amount of functions in order to
properly behave within the Ghini framework. The Ghini framework reserves
space to pluggable classes.

SP knows of all registered (plugged in) classes, they are stored in a
dictionary, associating a class to its plugin implementation.  SV has a slot
(a gtk.Box) where you can add elements. At any time, at most only one
element in the slot is visible.

A plugin defines one or more plugin classes. A plugin class plays the role
of a partial presenter (pP - plugin presenter) as it implement the callbacks
needed by the associated partial view fitting in the slot (pV - plugin
view), and the MVP pattern is completed by the parent presenter (SP), again
acting as model. To summarize and complete:


	SP acts as model,

	the pV partial view is defined in a glade file.

	the callbacks implemented by pP are referenced by the glade file.

	a context menu for the SP row,

	a children property.



when you register a plugin class, the SP:


	adds the pV in the slot and makes it non-visible.

	adds an instance of pP in the registered plugin classes.

	tells the pP that the SP is the model.

	connects all callbacks from pV to pP.



when an element in pV triggers an action in pP, the pP can forward the
action to SP and can request SP that it updates the model and refreshes the
view.

When the user selects a row in SP, SP hides everything in the pluggable slot
and shows only the single pV relative to the type of the selected row, and
asks the pP to refresh the pV with whatever is relative to the selected row.

Apart from setting the visibility of the various pV, nothing needs be
disabled nor removed: an invisible pV cannot trigger events!




bug solving workflow


normal development workflow


	while using the software, you notice a problem, or you get an idea of
something that could be better, you think about it good enough in order to
have a very clear idea of what it really is, that you noticed. you open an
issue and describe the problem. someone might react with hints.

	you open the issues site and choose one you want to tackle.

	assign the issue to yourself, this way you are informing the world that
you have the intention to work at it. someone might react with hints.

	optionally fork the repository in your account and preferably create a
branch, clearly associated to the issue.

	write unit tests and commit them to your branch (please do not push
failing unit tests to github, run nosetests locally first).

	write more unit tests (ideally, the tests form the complete description of
the feature you are adding or correcting).

	make sure the feature you are adding or correcting is really completely
described by the unit tests you wrote.

	make sure your unit tests are atomic, that is, that you test variations on
changes along one single variable. do not give complex input to unit
tests or tests that do not fit on one screen (25 lines of code).

	write the code that makes your tests succeed.

	update the i18n files (run ./scripts/i18n.sh).

	whenever possible, translate the new strings you put in code or glade
files.

	commit your changes.

	push to github.

	open a pull request.






publishing to production


	open the pull request page using as base a production line ghini-x.y,
compared to ghini-x.y-dev.

	make sure a bump commit is included in the differences.

	it should be possible to automatically merge the branches.

	create the new pull request, call it as “publish to the production line”.

	you possibly need wait for travis-ci to perform the checks.

	merge the changes.

	tell the world about it: on facebook, the google group, linkedin, ...






closing step


	review this workflow. consider this as a guideline, to yourself and to
your colleagues. please help make it better and matching the practice.
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Highlights

not-so-brief list of highlights, meant to whet your appetite.


taxonomic information

When you first start Ghini, and connect to a database, Ghini will
initialize the database not only with all tables it needs to run, but it
will also populate the taxon tables for ranks family and genus, using the
data from the “RBG Kew’s Family and Genera list from Vascular Plant Families
and Genera compiled by R. K. Brummitt and published by the Royal Botanic
Gardens, Kew in 1992”.  In 2015 we have reviewed the data regarding the
Orchidaceae, using “Tropicos, botanical information system at the Missouri
Botanical Garden - www.tropicos.org” as a source.




importing data

Ghini will let you import any data you put in an intermediate json
format. What you import will complete what you already have in the
database. If you need help, you can ask some Ghini professional to help you
transform your data into Ghini’s intermediate json format.




synonyms

Ghini will allow you define synonyms for species, genera, families. Also
this information can be represented in its intermediate json format and be
imported in an existing Ghini database.




scientific responsible

Ghini implements the concept of ‘accession’, intermediate between physical
plant (or a group thereof) and abstract taxon. Each accession can associate
the same plants to different taxa, if two taxonomists do not agree on the
identification: each taxonomist can have their say and do not need overwrite
each other’s work. All verifications can be found back in the database, with
timestamp and signature.




helps off-line identification

Ghini allows you associate pictures to physical plants, this can help
recognize the plant in case a sticker is lost, or help taxonomic
identification if a taxonomist is not available at all times.




exports and reports

Ghini will let you export a report in whatever textual format you need. It
uses a powerful templating engine named ‘mako’, which will allow you export
the data in a selection to whatever format you need. Once installed, a
couple of examples are available in the mako subdirectory.




annotate your info

You can associate notes to plants, accessions, species, .... Notes can be
categorized and used in searches or reports.




garden or herbarium

Management of plant locations.




database history

All changes in the database is stored in the database, as history log. All
changes are ‘signed’ and time-stamped.  Ghini makes it easy to retrieve the
list of all changes in the last working day or week, or in any specific
period in the past.




simple and powerful search

Ghini allows you search the database using simple keywords, e.g.: the name
of the location or a genus name, or you can write more complex queries,
which do not reach the complexity of SQL but allow you a decent level of
detail localizing your data.




database agnostic

Ghini is not a database management system, so it does not reinvent the
wheel. It works storing its data in a SQL database, and it will connect to
any database management system which accepts a SQLAlchemy connector. This
means any reasonably modern database system and includes MySQL, PostgreSQL,
Oracle. It can also work with sqlite, which, for single user purposes is
quite sufficient and efficient. If you connect Ghini to a real database
system, you can consider making the database part of a LAMP system
(Linux-Apache-MySQL-Php) and include your live data on your institution web
site.




language agnostic

The program was born in English and all its technical and user documentation
is still only in that language, but the program itself has been translated
and can be used in various other languages, including Spanish (86%),
Portuguese (100%), French (42%), to name some Southern American languages,
as well as Swedish (100%) and Czech (100%).




platform agnostic

Installing Ghini on Windows is an easy and linear process, it will not take
longer than 10 minutes. Ghini was born on Linux and installing it on ubuntu,
fedora or debian is consequently even easier. MacOSX being based on unix, it
is possible to successfully run the Linux installation procedure on any
recent Apple computer, after a few preparation steps.




easily updated

The installation process will produce an updatable installation, where
updating it will take less than one minute. Depending on the amount of
feedback we receive, we will produce updates every few days or once in a
while.




unit tested

Ghini is continuously and extensively unit tested, something that makes
regression of functionality close to impossible. Every update is
automatically quality checked, on the Travis Continuous Integration
service. Integration of TravisCI with the github platform will make it
difficult for us to release anything which has a single failing unit test.

Most changes and additions we make, come with some extra unit test, which
defines the behaviour and will make any undesired change easily visible.




customizable/extensible

Ghini is extensible through plugins and can be customized to suit the needs
of the institution.







          

      

      

    

  

    
      
          
            
  
representing the planned space

Botanic gardens are mostly organized in beds and greenhouses, and larger
beds are probably organized in smaller sections, while greenhouses might be
organized in tables, shelves, walls.

In the above software view on garden data, the numeric indications at either
end of the line connecting Location and Planting tells us that every
Planting can only belong to exactly one (1) Location, while every
Location may contain zero or more (0..n) Plantings.

A consequence of this constraint in the database is that your database needs
Locations in order to place Plants in the garden, so a good practice
is to start by entering a database Location for every physical bed
section, greenhouse table, or whatever might be the basic location unit in
your garden.




accepting a plant in the collection

When a plant (or a group of genetically identical plants) enters the collection,




building the history of a living plant




managing contacts




adding a taxonomist’s opinion




reproducing plants




updating taxonomy tree




producing report




engraving labels





          

      

      

    

  

    
      
          
            
  
Preparing a Database


SQLite - the easy choice

there’s nothing you need prepare if you are using SQLite.




PostgreSQL - scalable choice

allow network connections

create the bauble main user







          

      

      

    

  

    
      
          
            
  
Downloading the source

The Ghini source can be downloaded from our source
repository on github [http://github.com/Ghini/ghini.desktop].

If you want a particular version of Ghini, we release and maintain versions
into branches. You should git checkout the branch corresponding to the
version of your choice. Branch names for Ghini versions are of the form
bauble-x.y, where x.y can be 1.0, for example. Our workflow is to commit
to the master development branch or to a patch branch and to include the
commits into a release branch when ready.

To check out the most recent code from the source repository you will need
to install the Git [http://www.git.org] version control system. Git is
incuded in all reasonable Linux distributions and can be installed on all
current operating systems.

Once you have installed Git you can checkout the latest Ghini code with
the following command:

git clone https://github.com/Ghini/ghini.desktop.git





For more information about other available code branches go to
ghini.desktop on github [http://www.github.com/Ghini/ghini.desktop].




Development Workflow


production line

A bauble production line is a branch. Currently there is only one production
line, that is bauble-1.0.  In perspective, we will have several one, each in
use by one or more gardens.

As long as we have only one production line, I keep working on the master
branch, unless I later realize the work is going to take longer than one or
two days.




batches of simple issues

For issues that can be managed in one or two commits, and as long as there’s
no other activity on the repository, work on the master branch, accumulate
issue-solving commits, finally merge master into the production line
bauble-1.0.




larger issues

When facing a single larger issue, create a branch tag, and follow the
workflow described at

https://git-scm.com/book/en/v2/Git-Branching-Basic-Branching-and-Merging

in short:

git up
git checkout -b issue-xxxx
git push origin issue-xxxx





work on the new branch. When ready, go to github, merge the branch with
master, solve conflicts where necessary, delete the temporary branch.

when ready for publication, merge master into the production line.






Updating the set of translatable strings

From time to time, during the process of updating the software, you will be
adding or modifying strings in the python sources, in the documentation, in
the glade sources. Most of our strings are translatable, and are offered to
weblate for people to contribute, in the form of several .po
files. These po files receive contributions from weblate, and offer
lines without translation from new lines of code.

We have organized the translation of ghini as two separate repositories in
github, each repository being associated to sections of the same project on
weblate. Translation of the software is in ghini.desktop, the software
project, while translation of the documentation —itself part of the
software— is in a separate project, ghini.desktop-docs.i18n.

To update the po files relative to the software, you run a script from
the project root dir:

./scripts/i18n.sh





This will update your po files, something you need commit and push to
github.

To update the po filese relative to the documentation, you need a
up-to-date checkout of both projects. The root directory of the
ghini.desktop-docs.i18n project contains a script with an all telling name:

runme








Adding missing unit tests

If you are interested contributing to development of Ghini, a good way to
do so would be by helping us finding and writing the missing unit tests.

A well tested function is one whose behaviour you cannot change without
breaking at least one unit test.

We all agree that in theory theory and practice match perfectly and that one
first writes the tests, then implements the function. In practice, however,
practice does not match theory and we have been writing tests after writing
and even publishing the functions.

This section describes the process of adding unit tests for
bauble.plugins.plants.family.remove_callback.


What to test

First of all, open the coverage report index, and choose a file with low
coverage.

For this example, run in October 2015, we landed on
bauble.plugins.plants.family, at 33%.

https://coveralls.io/builds/3741152/source?filename=bauble%2Fplugins%2Fplants%2Ffamily.py

The first two functions which need tests, edit_callback and
add_genera_callback, include creation and activation of an object
relying on a custom dialog box. We should really first write unit tests for
that class, then come back here.

The next function, remove_callback, also activates a couple of dialog
and message boxes, but in the form of invoking a function requesting user
input via yes-no-ok boxes. These functions we can easily replace with a
function mocking the behaviour.




how to test

So, having decided what to describe in unit test, we look at the code and we
see it needs discriminate a couple of cases:


	parameter correctness

	
	the list of families has no elements.

	the list of families has more than one element.

	the list of families has exactly one element.





	cascade

	
	the family has no genera

	the family has one or more genera





	confirm

	
	the user confirms deletion

	the user does not confirm deletion





	deleting

	
	all goes well when deleting the family

	there is some error while deleting the family







I decide I will only focus on the cascade and the confirm
aspects. Two binary questions: 4 cases.




where to put the tests

Locate the test script and choose the class where to put the extra unit tests.

https://coveralls.io/builds/3741152/source?filename=bauble%2Fplugins%2Fplants%2Ftest.py#L273


Nota

The FamilyTests class contains a skipped test, implementing it
will be quite a bit of work because we need rewrite the
FamilyEditorPresenter, separate it from the FamilyEditorView and
reconsider what to do with the FamilyEditor class, which I think
should be removed and replaced with a single function.






writing the tests

After the last test in the FamilyTests class, I add the four cases I want to
describe, and I make sure they fail, and since I’m lazy, I write the most
compact code I know for generating an error:

def test_remove_callback_no_genera_no_confirm(self):
    1/0

def test_remove_callback_no_genera_confirm(self):
    1/0

def test_remove_callback_with_genera_no_confirm(self):
    1/0

def test_remove_callback_with_genera_confirm(self):
    1/0








One test, step by step

Let’s start with the first test case.

When writing tests, I generally follow the pattern:


	T₀ (initial condition),

	action,

	T₁ (testing the result of the action given the initial conditions)




Nota

There’s a reason why unit tests are called unit tests. Please
never test two actions in one test.



So let’s describe T₀ for the first test, a database holding a family without
genera:

def test_remove_callback_no_genera_no_confirm(self):
    f5 = Family(family=u'Arecaceae')
    self.session.add(f5)
    self.session.flush()





We do not want the function being tested to invoke the interactive
utils.yes_no_dialog function, we want remove_callback to invoke a
non-interactive replacement function. We achieve this simply by making
utils.yes_no_dialog point to a lambda expression which, like the
original interactive function, accepts one parameter and returns a
boolean. In this case: False:

def test_remove_callback_no_genera_no_confirm(self):
    # T_0
    f5 = Family(family=u'Arecaceae')
    self.session.add(f5)
    self.session.flush()

    # action
    utils.yes_no_dialog = lambda x: False
    from bauble.plugins.plants.family import remove_callback
    remove_callback(f5)





Next we test the result.

Well, we don’t just want to test whether or not the object Arecaceae was
deleted, we also should test the value returned by remove_callback, and
whether yes_no_dialog and message_details_dialog were invoked or
not.

A lambda expression is not enough for this. We do something apparently
more complex, which will make life a lot easier.

Let’s first define a rather generic function:

def mockfunc(msg=None, name=None, caller=None, result=None):
    caller.invoked.append((name, msg))
    return result





and we grab partial from the functools standard module, to partially
apply the above mockfunc, leaving only msg unspecified, and use this
partial application, which is a function accepting one parameter and
returning a value, to replace the two functions in utils. The test
function now looks like this:

def test_remove_callback_no_genera_no_confirm(self):
    # T_0
    f5 = Family(family=u'Arecaceae')
    self.session.add(f5)
    self.session.flush()
    self.invoked = []

    # action
    utils.yes_no_dialog = partial(
        mockfunc, name='yes_no_dialog', caller=self, result=False)
    utils.message_details_dialog = partial(
        mockfunc, name='message_details_dialog', caller=self)
    from bauble.plugins.plants.family import remove_callback
    result = remove_callback([f5])
    self.session.flush()





The test section checks that message_details_dialog was not invoked,
that yes_no_dialog was invoked, with the correct message parameter, that
Arecaceae is still there:

# effect
self.assertFalse('message_details_dialog' in
                 [f for (f, m) in self.invoked])
self.assertTrue(('yes_no_dialog', u'Are you sure you want to '
                 'remove the family <i>Arecaceae</i>?')
                in self.invoked)
self.assertEquals(result, None)
q = self.session.query(Family).filter_by(family=u"Arecaceae")
matching = q.all()
self.assertEquals(matching, [f5])








And so on


there are two kinds of people, those who complete what they start, and
so on


Next test is almost the same, with the difference that the
utils.yes_no_dialog should return True (this we achieve by
specifying result=True in the partial application of the generic
mockfunc).

With this action, the value returned by remove_callback should be
True, and there should be no Arecaceae Family in the database any more:

def test_remove_callback_no_genera_confirm(self):
    # T_0
    f5 = Family(family=u'Arecaceae')
    self.session.add(f5)
    self.session.flush()
    self.invoked = []

    # action
    utils.yes_no_dialog = partial(
        mockfunc, name='yes_no_dialog', caller=self, result=True)
    utils.message_details_dialog = partial(
        mockfunc, name='message_details_dialog', caller=self)
    from bauble.plugins.plants.family import remove_callback
    result = remove_callback([f5])
    self.session.flush()

    # effect
    self.assertFalse('message_details_dialog' in
                     [f for (f, m) in self.invoked])
    self.assertTrue(('yes_no_dialog', u'Are you sure you want to '
                     'remove the family <i>Arecaceae</i>?')
                    in self.invoked)
    self.assertEquals(result, True)
    q = self.session.query(Family).filter_by(family=u"Arecaceae")
    matching = q.all()
    self.assertEquals(matching, [])





have a look at commit 734f5bb9feffc2f4bd22578fcee1802c8682ca83 for the other
two test functions.




Putting all together

From time to time you want to activate the test class you’re working at:

nosetests bauble/plugins/plants/test.py:FamilyTests





And at the end of the process you want to update the statistics:

./scripts/update-coverage.sh










Plugins structure

Ghini is a framework for handling collections, and is distributed along
with a set of plugins making Ghini a botanical collection manager. But
Ghini stays a framework and you could in theory remove all plugins we
distribute and write your own, or write your own plugins that extend or
complete the current Ghini behaviour.

Once you have selected and opened a database connection, you land in the
Search window. The Search window is an interaction between two objects:
SearchPresenter (SP) and SearchView (SV).

SV is what you see, SP holds the program status and handles the requests you
express through SV. Handling these requests affect the content of SV and the
program status in SP.

The search results shown in the largest part of SV are rows, objects that
are instances of classes registered in a plugin.

Each of these classes must implement an amount of functions in order to
properly behave within the Ghini framework. The Ghini framework reserves
space to pluggable classes.

SP knows of all registered (plugged in) classes, they are stored in a
dictionary, associating a class to its plugin implementation.  SV has a slot
(a gtk.Box) where you can add elements. At any time, at most only one
element in the slot is visible.

A plugin defines one or more plugin classes. A plugin class plays the role
of a partial presenter (pP - plugin presenter) as it implement the callbacks
needed by the associated partial view fitting in the slot (pV - plugin
view), and the MVP pattern is completed by the parent presenter (SP), again
acting as model. To summarize and complete:


	SP acts as model,

	the pV partial view is defined in a glade file.

	the callbacks implemented by pP are referenced by the glade file.

	a context menu for the SP row,

	a children property.



when you register a plugin class, the SP:


	adds the pV in the slot and makes it non-visible.

	adds an instance of pP in the registered plugin classes.

	tells the pP that the SP is the model.

	connects all callbacks from pV to pP.



when an element in pV triggers an action in pP, the pP can forward the
action to SP and can request SP that it updates the model and refreshes the
view.

When the user selects a row in SP, SP hides everything in the pluggable slot
and shows only the single pV relative to the type of the selected row, and
asks the pP to refresh the pV with whatever is relative to the selected row.

Apart from setting the visibility of the various pV, nothing needs be
disabled nor removed: an invisible pV cannot trigger events!





          

      

      

    

  

    
      
          
            
  
Structure of user interface

The user interface is built according to the Model-View-Presenter
architectural pattern.  In theory, but also in the practice of all new parts
of the software:


	The view is described as part of a glade file. This includes the
signal-callback associations. The base class is GenericEditorView
defined in bauble.editor. Create an instance of the base class,
passing it the glade file name and the root widget name, then handle
the instance to the presenter constructor.

	The model simply follows the sqlalchemy practices. The presenter
continuously updates it according to changes in the view. The
presenter commits all model updates to the database if the
view is closed successfully, or rolls them back if the view is
canceled.

	The subclassed presenter defines and implements:
	widget_to_field_map, the association from widget name to name of
model attribute,

	view_accept_buttons, the list of widget names which, if
activated by the user, mean that the view should be closed,

	all needed callbacks,

	optionally, it plays the model role, too.







A well behaved presenter uses the view api to query the values
inserted by the user or to forcibly set widget statuses. Please do not learn
from the practice in our older presenters, most of which directly handle
widgets, something that prevents us from writing unit tests.

There is no way to unit test a subclassed view, so please don’t subclass views.

The base class for the presenter, GenericEditorPresenter defined in
bauble.editor, implements many useful generic callbacks.

We use the same architectural pattern for non-database interaction, by
setting the presenter also as model. We do this, for example, for the JSON
export dialog box. The following command will give you a list of
GenericEditorView instantiations:

grep -nHr -e GenericEditorView\( bauble





An other good example of Presenter/View pattern (no model) is given by the
connection manager.




Extending Ghini with Plugins

Nearly everything about Ghini is extensible through plugins. Plugins
can create tables, define custom searchs, add menu items, create
custom commands and more.

To create a new plugin you must extend the bauble.pluginmgr.Plugin
class.

The Tag plugin is a good minimal example, even if the TagItemGUI
falls outside the Model-View-Presenter architectural pattern.
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